ANALISE DE UMA VIGA DE CONCRETO ARMADO COM ABAQUS 6.13

1. INTRODUCAO

1.1. DESCRICAO DO PROBLEMA:

Implementar os modelos disponiveis no software Abaqus a fim de

caracterizar o material concreto e analisar o surgimento de fraturas numa viga

de concreto armado sujeita a flexao.
Concrete Damaged Plasticity (CDP)
Extended Finite Element Method (XFEM)

1.2. PROPRIEDADES GEOMETRICAS
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Espacamento entre a barras = 25mm
Diametro das barras = 25mm
Area da secédo transversal das barras = 4.909cm?

Espacamento lateral = 37.5mm
Espacamento entre as barras e a base da Viga = 37.5mm



1.3.PROPRIEDADES DOS MATERIAIS

Aco CA-50
Fyk = 500Mpa
Mddulo de Elasticidade = 210Gpa
Coeficiente de Poisson = 0.3
Energia de Fraturamento = 5N/mm
Concreto C30
Fck = 30Mpa
Fyk = 1.732Mpa
Mdédulo de Elasticidade = 33Gpa
Coeficiente de Poisson = 0.2
Energia de Fraturamento = 0.08N/mm
Concrete Damage Plasticity
Angulo de Dilatagéo = 38°
Excentricidade = 0.1
Relacéo fcb/fco = 1.16
K =0.6666



Comportamento a compressao

Comportamento a tracdo

Tenséo (Pa) Deformacéao Tenséo (Pa) Deformacdo de
nao-elastica fraturamento
6.61E6 0 1.732E6 0
9.68E6 0.0000066
12.58E6 0.000018
15.34E6 0.000035
17.93E6 0.000056
20.36E6 0.000082
22.64E6 0.00011
24.76E6 0.00014
26.72E6 0.00019
28.52E6 0.00023
30.17E6 0.00028
31.66E6 0.00034
32.99E6 0.00040
34.16E6 0.00046
35.18E6 0.00053
36.04E6 0.00060
36.74E6 0.00068
37.29E6 0.00076
37.68E6 0.000857
37.92E6 0.00095
38.00E6 0.0010
37.92E6 0.0011
37.68E6 0.0012
37.29E6 0.0013
36.75E6 0.0014
36.05E6 0.0016
35.19E6 0.0017
34.18E6 0.0018
33.01E6 0.0019
31.69E6 0.0021
30.21E6 0.0022
28.58E6 0.0024
26.79E6 0.0025
24.85E6 0.0027

2. RESOLUCAO

2.1.INICIO DA ANALISE




v' Se vocé ainda ndo iniciou o programa Abaqus/CAE, cmd no
Menu Iniciar para abrir o Prompt de Comando e nele abq6131

cae para executar o Abaqus.
v" Em Create Model Database na caixa Start Session que aparece,

With Standard/Explicit Model.

2.2.PRE-PROCESSAMENTO

v No menu Model a esquerda, com o botdo direito em Model-1 e

Rename. AnaliseDeFraturaEmVigadeConcretoArmado
v" No menu Model a esquerda, dé duplo cligue em Parts, no campo Name

VigaDeConcreto, e as opcoes: 3D, Deformable, Solid,

Extrusion. Em approximate size 10. em Continue...
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2 simuLia

v em Create Lines: Connected na caixa de ferramentas e
as seguintes coordenadas -2.6,0 — -2.5,0 - 25,0 - 2.6,0 — 2.6,04 —
25,04 - 0.25,04 - 0.125,04 - -0.125,0.4 — -0.25,0.4 — -25,04 —
-2.6,0.4 — -2.6,0. a fungéo e em Done. Na Janela Edit
Base Extrusion, 0.25 no campo Depth. em OK.
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v" Na caixa de ferramentas Create Wire: Point to Point, e na
janela g abre em Add... as linhas que delimitam a area
central de aplicacao de carga, conforme a imagem. em OK.
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v Também na caixa de ferramentas, Partition Cell: Define
Cutting Plane e na opgado Point & Normal. sobre um
ponto de coordenada x = -25 e sobre uma das arestas
longitudinais da viga em Create Partition. para um ponto
de coordenada x = 2.5, x = 0.25 e x = -0.25 . em Done para

desligar a fungéo.
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v No menu Model a esquerda, dé duplo clique em Parts(1), no campo
Name digite Barra de Ac¢o, e selecione as opgles: 3D, Deformable,

Wire, Planar. Em approximate size digite 10. Clique em Continue...
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o} datebage hos been crested
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v~ Clique em Create Lines: Connected na caixa de ferramentas e digite

-2.6,0.05 — 2.6,0.05. Desligue a fung&o e clique em Done.
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v No menu Model a esquerda, dé duplo cligue em Materials. Na janela
Edit Material, digite Ago no campo Name: e selecione

Mechanical>Elasticity>Elastic e digite 210E9 em Young’s Modulus e

0.3 em Poisson’s Ratio.
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v’ Selecione Mechanical>Damage  for  Traction Separation
Laws>Maxps Damage, digite 500E6 em Max Principal Stress. Clique
em Suboptions>Damage Evolution, altere Type: para Energy e digite

5000 em Fracture Energy. Clique em OK nas duas janelas.
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v" Novamente, dé duplo clique em Materials (1). Na janela Edit Material,

digite Concreto no campo Name:, selecione
Mechanical>Elasticity>Elastic, digite 33E9 em Young’s Modulus e

0.2 em Poisson’s Ratio.
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v’ Selecione Mechanical>Damage  for  Traction Separation
Laws>Maxps Damage, digite 1.732E6 em Max Principal Stress.
Clique em Suboptions>Damage Evolution, altere Type: para Energy

e digite 80 em Fracture Energy. Clique em OK.
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v~ Selecione Mechanical>Plasticity>Concrete Damage Plasticity,
38-0.1-1.16 —0.6666 — 0, nessa ordem, na aba Plasticity.
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3 nev aode] datsbase has been created
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v' Altere para a aba Compressive Behavior, digite 6.61E6 em Yield

Stress (tecle TAB), 0 em Inelastic Strain (tecle Enter) e continue

como na imagem.
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v" Altere para a aba Tensile Behavior, digite 1.732E6 em Yield Stress
(tecle TAB), 0 em Cracking Strain e clique em OK.
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v No menu Model a esquerda, dé duplo cligue em Sections. No campo
Name: digite SecdoBarra, em Category selecione Beam, e em Type
selecione Truss. Cliqgue em Continue... Na janela Edit Section,

selecione em Material: Aco, digite 0.0004909 em Cross-sectional

area e clique em OK.
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A nev aodel database has been created
The nodel "Model-1" has been created

v’ Repita para criar a SecaoConcreto, selecionado Solid e

Homogeneous, e o material Concreto.
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A nev aodel database has been created
The nodel "Model-1" has been created

v" No menu Model a esquerda, abra Parts (2)>Barra de Aco e dé duplo

cliqgue em Section Assighments. Selecione a barra e clique em Done.

Selecione SegdoBarra e clique em OK.
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v' Repita para a parte VigaDeConcreto, selecionando a Se¢doConcreto.
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v" No menu Model a esquerda, abra Assembly, dé duplo clique em
Instances, na janela Create Instance selecione a parte
VigaDeConcreto e clique em Apply. Selecione a parte Barra de Aco e

clique em Apply por quatro vezes. Feche a janela.
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3 nev node] datsbase has been created
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v" Na barra de ferramentas clique em Remove Selected, altere entities
to remove: para Instances, selecione a Viga e cligue em Done duas
vezes.

v' Na caixa de ferramentas, clique em Translate Instance, selecione a

barra e clique em Done. Use 0,0,0 para coodenada incial, tecle enter,

0,0,0.2 para coordenada final, tecle Enter e clique em OK.
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v' Repita para as outras trés barras, utilizando 0,0,0 como coordenada
inicial e [ 0,0,0.15 - 0,0,0.1 — 0,0,0.05 ] como final.
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A simuLia

. 200.E-03 with respect to the assembly coor
. 150.E-03 with respect to the assembly coor
© 100_E-03 with respect

. 50.E-03 vith respec

to the assembly coor:
to the assembly coord:

v" No menu model a esquerda, dé duplo clique em Steps. Digite
Carregamento no campo Name: e Clique em Continue....

¥ Na janela Edit Step, altere Nlgeom: para On, selecione Specify
damping factor em Automatic stabilization: e digite 0.0001, marque
a opcdo Use adaptive stabilization with max. ratio of stabilization to

strain energy: e digite 0.05.
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Off(This seting controls the inclusion of noniinear effects
of large displ nd affects subsequent steps.)

Inmibg |

A simuLia

0., 200 E-03 with respect to the ass
. 00) 150.E-03 with respect to the ass
0.) 100 E-03 wath respect to the ass
0.} 50.E-03 with respect to the assenb!

v' Abra a aba Incrementation, altere Maximum number of increments

para 10000, Increment size:>Initial para 0.01, Increment



size:>Minimum para 1E-15, Increment size:>Maximum para 0.01 e

clique em OK.
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v' Na barra do menu principal, clique em Other>General Solution
Controls>Edit>Carregamento. Na janela de aviso clique em
Continue... Clique em Specify:, abra a aba Time Incrementation,
marque a opg¢ado Discontinuous analysis. Clique sobre a primeira

opcgao More e altere o valor de la para 20. Clique em OK.

x
ot View Step Output Other Toos Plugins Help K? 3 DEXN
LESE=gg+c  RBNSIO EA i 8 asembiy s [ - @ @@ © K] " BB
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4 General Slution Contrl: Edtor [T
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© Propagte from previous tep
I parameters to thir st defned defauits
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PS simuLia
. 200.E-03 with respect to the sssebly 2
10 IS0E0 itk a1 b1y [
{100 E03 itk a1 b1y Sheten e
© S0.E-03 with respoct to the scombly coordinate systen =

v" No menu model a esquerda, abra Field Output Requests (1) e dé

duplo clique em F-Output-1. Marque as opcoes



Failure/Fracture>PHILSM, Level set value phi e
State/Field/UserITime>STATUSXFEM, Status of xfem element.
Clique em OK.
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A simuLia

The instance Barra de Ago-4 vas tra: 0. 200 E:

The instance Barra de AGo-3 was translated by 0.) 0| 150.E-03 vith respect to the assembly coordimate system
The instance Barra de AGo-2 vas translated by 0. 0

The instance Barra de ACo-1 vas translated by 0., 0

[ e 7o, gL e B creried
Rslated by 0 L @ |

TR

. 100_E-03 with respect to the assembly coordinate system
. 50.E-03 with respect to the assembly coordinate system

v No menu model a esquerda, dé duplo cligue em Constraints. Na janela

Create Constraint, no campo Name digite Aco-Concreto, em Type

selecione Embedded region e clique em Continue...
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$4§ Contact Controk:
i Contact Initializations
A Contact Stabilizations

& Create Constraint |2

Name: | Ago-Concreto

Constraints
B Comnector Sections
@ F Fieds
Py Ampltudes
05 Loads b
L oscs
L, Predefined Felds
B Remeshing Rues
2 Optimisstion Tasks

I sketches 0
w0 v | [l Ftoutthe Crste Constaintdinlog

The nodel “Hodel1* hes been created
[ |The Tistance Borra de koo d was franslated by 0.. 0.. 200.E-03 with respect to the assembly coordinate system

0
The instance Barra de AGo-3 was translated by 0.) 0| 150'E-03 with respect to the assembly coordimate system
The instance Barra de AGo-2 was translated by 0.. 0| 100 E-03 vith respect to the assembly coordinate system
The instance Barra de AGo-1 was translated by 0., 0. 50.E-03 with respect to the assembly coordinate system

A simuLia

TR

v’ Selecione as quatro barras e cliqgue em Done. Cligue em Select

Region. Na barra de ferramentas clique em Invert Display, selecione



toda a viga e clique em Done. Na Janela que abre apenas clique em
OK.
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90 Steps 2)
8% Fild Output Requests (1)

Name: Ago-Concreto
Type: Embedded region

§ Embedded region: m Set1
§ Hostregion:  s.Setd
Weight factor roundof toleance: | 1E-005
Tolerance method: © Absclute © Fractonal ® Both
& F-Output-1
@B History Output Requests (1)
b Time Points
B ALE Adsptive Mesh Constrints
T nteractions
B Interaction Properties
# Contact Contros
i Contact Initializations
6 Contact Stabilzations
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{B Connector Sections
@ F Fields

Py Ampltudes

05 Loads b
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L Predefined Felds

Absolute extrior tolerance: [0
Fractional eterior tolerance: 005

Note: I both absolute and fractional tlerance are specified,
the smaller tolerance will be used during analysis.
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B Remeshing Rues
0% Optimization Tasks
I Sketches u
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The instance Barra de Ago-2 vas translated by 0.

The nodel “Hodel1* hes been created
[ |The Tistance Borra de koo d was franslated by 0.. 0.. 200.E-03 with respect to the assembly coordinate system
The intance Berra de Aol vas translated by 0.

0
The instance Barra de AGo-3 was translated by 0.) 0| 150'E-03 with respect to the assembly coordimate system
0] 100 E-03 with respect to the sssembly coordinate system
0.} 50.E-03 with respect to the assembly coordinate system
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v" Na barra do menu principal, cligue em Special>Crack>Create...,
selecione XFEM e clique em Continue... Altere Select the crack

domain para geometric cells, dé um clique sobre a parte central da

viga e na janela que abre clique em OK.
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§{ Contact Controls
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A Contact Stabilizations
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B Connector ectons
@ F Fieds

P Amplitudes

4 Loads &

L scs
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BX Optimization Tasks
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The nodel “Hodel1* hes been created
[ |The Tistance Borra de koo d was franslated by 0.. 0.. 200.E-03 with respect to the assembly coordinate system
The instance Barca d= Azay vas translated by 010 0.0 150'E703 Witk Tespect 1o the asseanly coonbinate Syeten
0

. 100 E-03 with respect to the assembly coordinate system
. 50.E-03 with respect to the assembly coordinate system

5 Speciy contactpropey |

The instance Barra de Ago-2 vas translated by 0.
The instance Barra de Ago-1 vas translated by 0..

TR

v" No menu model a esquerda, dé duplo cligue em Interactions. Na janela

Create Interaction, no campo Name digite ProcessoDeFraturamento,



em Types for selected Step, altere Step para Initial, selecione XFEM
crack growth e clique em Continue... Clique em OK.
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I sketches 0
B i y | (€] Filoutthe Create Interaction dialog

The nodel “Hodel1* hes been created
[ |The Tistance Borra de koo d was franslated by 0.. 0.. 200.E-03 with respect to the assembly coordinate system

A simuLia

0
The instance Barra de AGo-3 was translated by 0.) 0| 150'E-03 with respect to the assembly coordimate system
The instance Barra de AGo-2 was translated by 0.. 0| 100 E-03 vith respect to the assembly coordinate system
The instance Barra de AGo-1 was translated by 0., 0. 50.E-03 with respect to the assembly coordinate system
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v" No menu model a esquerda, dé duplo clique em BCs. Na janela Create
Boundary Condition, altere Types for Selected Step para
Displacement/Rotation e cligue em Continue... Selecione a area
inferior direita da Viga e clique em Done. Marque Ul , U2 e U3 na
janela Edit Boundary Condition e clique em OK.
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A simuLia

The instance Barra de Ago-d vas translated by 0., 0. 200 E-03 with respect to the assembly coordinate system

The instance Barra de AGo-3 was translated by 0.) 0| 150'E-03 with respect to the assembly coordinate system

The instance Barra de AGo-2 was translated by 0. 0. with re:

The instance Barra de ACo-1 vas translated by 0., 0 . 50 E-03 with respect to the assembly coordinate system
The interaction ‘ProcessoDeFraturamento’ has been created

T

v' Repita para a area inferior esquerda da Viga, selecionando apenas U2 e
us.
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v' Dé duplo clique em BCs (2), altere Step: para Carregamento e Types
for Selected Step para Displacement/Rotation. Clique em Continue...
Marque a area superior central da Viga e clique em Done. Marque U2
e digite -0.025. Clique em OK.
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v Na barra de contexto, em Module, selecione Mesh, e em Object,
selecione Part>Barra de Aco. Na barra do menu principal, clique em
Mesh>Element Type e selecione a barra. Clicando em Done, abrira a
janela Element Type. Em Family, selecione Truss e em Geometric

Order selecione Linear. Clique em OK.



0@

R DD B B T Mesh defauies i/ HOYORCY (X

S Model Database

2 Element Type. (=)

Eement Library Famiy
© Standard © Bpict | Pisoslectic
Pipe
. Therml ecic g
( =
[ime]
7] Hybrid formulation

Element Controls

Scaling factors: Linear bulk viscosity: |1

T3D2: A2-node inear 3-D truss,

Note: To select an element shape for meshing,
select "Mesh-> Controls" from the main menu bar.
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v
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A simuLia

by 0. 0,
by 0. 00 2
by 0. 0., 50 E-03 with respect to the assembly coordinate system

150 E-03 with respect to the assenbly coordinate system

Go-1
Bl 2 2oDeF s been created
The nodel database has been saved to "C:\Users\GustavaliDropbow\INICIACAO CIENTIFIC

3.0.cae"

v Na barra do menu principal, clique em Seed>Part, digite 0.25

Approximate global size e clique em Done.
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A simuLia

by 0. 0., 50 E-03 with respect to the assembly coordinate system
s been created
TACAO CIENTIFIC)

3.0.cae”

v' Na barra do menu principal, clique em

pergunta “OK to mesh the part?”, clique Yes.

Mesh>Part. Aparecera a

Na barra de contexto, em Object, selecione Part>VigaDeConcreto. Na

barra do menu principal, cligue em Mesh>Element Type e selecione

toda a Viga. Clicando em Done, abrira a janela Element Type. Em

Family, selecione 3D Stress, em Geometric Order selecione Linear e

desmarque a opcdo Reduced integration. Clique em OK.
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The interaction *Proces
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[ e See neve roen 52535
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em Seed>Part, digite

3.0.cae”

Done.

B Fle Model Viewpor Vew Seed Mg Adsptvity Femtwe ook Plagins Hep K7

o8 AL EIE @

Mesh

[ Mesh defauts

099 L@

Wode | Rt |

] Mode: [ AntebeatuntmiigabeConaromade 7] Obect © Asemly @ rs g beConarto [

S Model Database

EEEY maﬂ;

B, Composite Loyups
@4 Engineering Features
En Mesh (Empty)

wa wu‘

@z Mat
£ Calibrations
5 Sections (2) &
- Profiles By
S48 Assembly |
@ @ Instances (5) 45 Ly
. Position Constraints o
@8 Features (1) &
@iy sets (1) 4
™ Sufaces 5 b,

18 Comector Asignments
(68 Engineering Festures

ol Steps 2) A =

S5 Field Output Requests 1) B 4 Global Seeds
@ F-Output-1 = Sizing Controls

@B History Output Requests
FElee G bapes o) L Apprsmte b sz 085

5 Time Points. a e
fip ALE Adaptive Mesh Constraints

@] Curvature control

M deiaion facor 00 <WL <101 01 |

(Approximate number of clements per cicle: )

® ﬁ Interactons (1)
& Ineracton Properies

4 Contact Contros

i Contactntlizatons
i Contact Stabilzatons =
] Constraints 1)

{8 Connector Sections
@ F Feds
Py Ampitudes

04 Loads

Minimun sze control
© By fraction of global size (00 < min <10) 01

© By absolute value (00 < min < global size (0011

B2 Optimisston Tasks
I Sketches

8 Amottions

188 Anayss

B jobs

g Adsptiity Processes

5% Co-orcutions

B opimisiontreces

" 3 4[] set the data using the Global Seeds dialog.

A simuLin

TACAO CIENTIF)

21 elenents have been generated on part: Barra de Aoo
Global seeds have been assigned

The nodel databese has been saved to '
[ |cibal"Seeds fave been s
= Global Scads have been asei

v' Na barra do menu principal, clique

3.0.cae" &

em Mesh>Part. Aparecera a

pergunta “OK to mesh the part?”, clique Yes.



[ fle Model Viewport View Seed Mesh Adoptivty Featwe Tools Plugeins
DEESE & KRR
[Vode ezl Module[{Mesh 7| Modet: |- AnslseDefraturaEmigaDeConcretohmado [7| Object: © Assembly © Part: < Vigs De Conerto |1

B H: e o]l

@Bz Materiss @) [

S5 Field Output Requests 1) B

@ F-Output1 fs

@ Bg History Output Requests (1) ‘\A (i}
ime Paint Py

Help K7

giEAMY  Haeo:

BODEE B s [F- Q@m0 K CR.E

; Composite Layups ™
@88 Engineering Festures
o Mesn ldd

A simuLin

d
d on part: Barra de Aco

=
ted on part: Viga De Concreto =4

2.3.PROCESSAMENTO

=

ATCAE 1T

e Model Viewpom View lob Adsptiviy Co-eecution Optimamtion Tooks Plugins Hep AP

hY

No menu model & esquerda, dé duplo cliqgue em Jobs, digite

AnaliseDeFraturaEmVigaDeConcretoArmado no campo Name: e clique

em Continue... Clique em OK.
Abra  Jobs (1), «cligue com o botdo  direito em

AnaliseDeFraturaEmVigaDeConcretoArmado e clique em Submit.

EI LI IEY RGN T T 18 SR @O0

[ Model | R Modue: [F1ob R F sep:[F Commgrmeno 1

Err. H:oweo 2m

g Materials (2)

& Casbrations =

57 Field Qutput Requests (1)
5 F-Output

B History Output Reguests (1)
s Time points
3

o BC: )
L Predefined Felds
By Remeshing fukes Switch Context CirlSpace
[ Optimization Tasks i

Global sesds have besn sszisnec
i1 elsnents have been gemeratec ReUts
= Global
200 elenents have general rato =
The job *AndliseDeFraturafalig: Espot » peen cres! ted

Az e A
e M HE

A Contact Stabiizstions
o] Constraints (1)
1B connectar Sections

Copy.
Rerame..
Delete.. e o

i
Data Check

i 1 5 simuLia
Mot

sseds have besn szsigne:

2.4.PREVIA DO POS-PROCESSAMENTO




8, 811
(Avg: 75%)

-4,832e+07

AZ5e407
-4 B32e407




